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HVE Version 4 Now Available 

The wait is finally over!  HVE users can now enjoy 
the same functionality and capabilities they were 
accustomed to with the SGI version, but with the 
versatility and speed of using HVE directly on their 
PC. HVE Version 4.00 provides the serious 
professional with a sophisticated, yet easy-to-use  
tool to study human and vehicle dynamics from 
the convenience of their own desk (or field 
location, since HVE can now be used on a laptop).  
A wide variety of simulations ranging from vehicle 
handling studies to real-world crashes can be 
easily performed.   

 

 

 

 

 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The new single-window interface design provides 
the user with easy access to data entry dialogs, 
toolbars, event controllers and other time-saving 
features.  The Editor buttons located on the toolbar 
allow the user to move quickly between Human, 
Vehicle, Environment, Event and Playback modes 
simply by clicking on the appropriate icon.  The 

user can also quickly create new objects (e.g., 
humans, vehicles, events) by clicking on Add New 
Object (the +  icon) or access the information 
dialog for an active object by clicking on Object 
Info (the pointing hand icon).  Other routinely used 
functions are also located on the toolbar.  

 

 

 

 

 

 

 

 

 

Several new data-entry and control enhancements 
have been incorporated in the new interface to 
help HVE users set-up and execute events faster.  
The new Set Position/Velocity dialog now allows 
instant access to the Initial Position or any target 
positions simply by clicking on the drop-down list. 
This eliminates the need to return to the main 
menu to re-open the dialog to set-up each position 
as is required in the SGI version of HVE (and even 
in HVE-2D).    
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The new Driver Controls dialog allows the user to 
quickly enter data for all driver inputs, such as 
Steering, Braking, Throttle, Gear and Path 
Follower by simply selecting the appropriate tab on 
the dialog.  This allows the user to enter and verify 
their time-based inputs for driver controls all within 
the same dialog.  

 

 

 

 

 

 

 

 

 

 

 

 

The Event Controller slider now allows the user to 
review simulation results time-step by time-step 
directly in the Event Editor.  The numeric displays 
around the event controller provide quick 
reference to user-selected simulation time controls 
and also the current time-step and frame of 
simulation.  

  

 

 

 

 

 

 

 

Numerical data outputs at every time-step of 
simulation are available by selecting Show Key 
Results from the Options menu.  The user can 
select to display results from variable groups for 
kinematics, kinetics, accelerometers, damage, 
tires, wheels, inter-vehicle connections, driver, 
contacts, belts, airbags, and joints depending upon 

the object and the simulation or reconstruction 
model being used for the event.  

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A complete time-based output of those same 
variable groups is available by selecting the 
Variable Output report in the Playback Editor.  

 

 

 

 

 

 

 

The Path Follower is available in several 
simulation models, providing users with an 
effective means of determining driver control 
requirements or vehicle performance capabilities 
required to negotiate a specific path of travel.  The 
Path Follower can also be used to quickly  set-up a  
simulation run  simply by placing target positions 
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at appropriate locations, instead of having to 
determine appropriate time-based driver steering 
inputs. 

 

 

 

 

 

 

 

 

Once the simulation work is complete, the new 
Playback Window dialog design allows users to 
quickly combine multiple simulation events into a 
complete sequence, produce compressed movie 
files for real-time playback, and route the real-time 
playback direct to a special viewer designed to 
work with your computers video card or peripheral 
for output to videotape.  To make a combined 
sequence, the user quickly selects the simulation 
events they wish to combine using the Active 
Trajectory Simulation Windows list, edits the 

Tdelay time, verifies the new Tstart and Tend 
times, then plays the combined event and views 
the results in the Playback Window.  The Playback 
Window can be routed to video compressor for 
creating a Video for Windows (AVI) movie file, 
which can then be played back to present the 
simulation in real-time. 

On-line help is available within HVE, providing 
users with a quick means of finding definitions for 
terms used in HVE and also information on how to 
use specific functionality when setting up and 
executing reconstructions or simulations.  

 

 

 

 

 

 

 

 

 

 

 

 

To order a copy of HVE Version 4.00 and  
experience the new interface for yourself, contact 
EDC Sales at 503.644.4500 extension 2 or by 
email at sales@edccorp.com  
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Testing, Testing, Testing 

Those words can still be heard echoing through 
the halls at EDC.  The amount of testing that HVE 
Version 4.00 has been put through during the 
development process equates roughly to 4.5 
person-years.  The testing protocols included 
procedures for testing for correct appearance, 
dialog behavior, functionality, and performance.  
HVE Version 4.00 has also been tested for 
compatibility with various hardware configurations 
and  Windows operating systems.   

The above photograph shows one series of tests 
where six computers (three with one hardware 
configuration, the other three with another) were 
set-up side by side to test for consistency of HVE 
operation and performance using Windows 98, NT 
and 2000 as the operating system. This test was 
designed to isolate any irregularities found during 
testing directly to either the hardware configuration 
or the operating system. A methodical series of 
steps representing a typical user's actions required 
to set-up and execute simulations were performed.  
At each step, a comparison was made to ensure 
that the same expected behavior was observed on 
the different operating systems and on the 
different hardware configurations.  We did find 
several unexpected behaviors that we were able to 
identify, isolate the cause of and then correct the 
code to eliminate the wrong behavior.   

This type of testing is just one example of the kind 
of thorough, intensive testing that HVE Version 
4.00 has been put through over the past months.  
Our investment in time and effort up front to test, 
test, test means that our users can focus their time 
on productivity and their analyses from the 
moment they first sit down to use HVE. 

Why SIMON? 

EDC has recently introduced a new, full-featured 
simulation model, called SIMON (SImulation 
MOdel Non-linear). Users have asked why they 
should choose SIMON over one of our other 3-
dimensional simulation models, such as EDVSM 
or EDVDS. Well, there are several reasons for 
selecting SIMON as the tool of choice. 

First, there are the technical reasons. SIMON has 
the most advanced rigid body dynamics model in 
the EDC toolbelt.  

For example, you might choose SIMON over 
EDVSM because SIMON does not assume bi-
lateral symmetry: the CG can be located to the left 
or right of the vehicle’s geometrical centerline. 
Occupants and payloads may be added and they 
affect the CG location (including CG height). 
Vehicles with displaced wheels (as from collision 
damage) are properly modeled. Dual tires may be 
assigned at any wheel location and the actual tire 
deflection for each individual tire is used for the 
tire radial force calculations (for example, an outer 
dual tire climbing a curb is correctly modeled). In 
addition, the SIMON aerodynamics model is not 
limited to head-on forces in still air. SIMON 
simulates aerodynamic forces on all six surfaces 
(front, right, back, left, top, bottom) as well as up 
to two user-defined aerodynamic devices, such as 
an air dam or spoiler. And wind speed and 
direction are accounted for, so the simulation of 
trailers in a cross-wind is possible.  

You might choose SIMON over EDVDS because 
SIMON models a wider range of vehicle-trailer 
configurations, including A-trains and B-trains with 
any number of trailers. SIMON models both 
independent and solid axle suspensions, so you 
could simulate a passenger car towing a utility 
trailer. In addition, SIMON includes aerodynamic 
drag, a feature missing from EDVDS. 

There are also practical reasons for selecting 
SIMON over other simulation models. The main 
reason is that any number of vehicles (including 
articulated vehicles) may be included in a single 
simulation. This is a great time savings, as well as 
a convenience to the analyst. There is no need to 
combine several independent simulations in the 
Playback Editor; all the vehicles are included in  a 
single event. SIMON also allows you to place 
humans in the environment. This feature is useful 
for visibility studies. 
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DyMESH 

SIMON will include as an optional feature the 
DyMESH collision algorithm (the DyMesh option is  
not yet available; see Status Report, below). 
DyMESH is a truly 3-dimensional kinetic 
simulation of vehicle-to-vehicle and vehicle-to-
barrier collisions. DyMESH is similar to finite 
element methods, except it executes an entire 
collision simulation in a few minutes, rather than 
several hours. DyMESH is kind of like “cheap finite 
element.” Compared to finite element, DyMESH 
achieves its great efficiency by removing the node  
constraints from each vertex and by making the 
nodes massless. EDC has just received a patent 
on the DyMESH technology from the US Patent 
Office (U.S. Patent No. 6,195,625). There is no 
other practical method available for the kinetic 
simulation of crashes. 

Status Report 

EDC will be presenting a technical paper 
describing the internal workings of the SIMON 
model at the SAE International Congress (refer to 
SAE Paper No. 2001-01-0503; it will be presented 
both in the Vehicle Dynamics and Accident 
Reconstruction sessions).  

At this time, SIMON has undergone a thorough 
validation. The validation includes comparisons 
with EDVSM, EDVDS and actual handling 
experiments. This validation will be published, first 
in a White Paper presented at the 2001 HVE 
Forum in Santa Fe, and then as part of an overall 

validation that includes collision experiments (see 
below). 

The DyMESH collision algorithm is a substantial 
undertaking. The basic model was finished nearly 
a year ago. Since that time, EDC has been 
refining  the model to make it a useful commercial 
product. We recognize there is a big difference 
between a prototype that works in-house and a 
fully functional commercial product that is usable 
by our customers. We are close to achieving that 
required level of refinement. 

EDC has made arrangements with Exponent 
Failure Analysis to obtain several complete data 
sets from well-instrumented collision experiments 
conducted at Exponent’s Phoenix Test Facility. 
Handling experiments with unit and articulated 
vehicles are included also. SIMON’s validation 
study will be extended to include comparisons with 
these additional handling and collision 
experiments. A final validation will be published 
that includes the initial studies (described above) 
and the results from the additional handling and 
collision experiments. 

Availability 

SIMON is available now on both the SGI and PC 
platforms. SIMON’s DyMESH option is not yet 
available on either platform. We are not able to 
give an exact release date at this time. The next 
edition of the Newsletter will provide updated 
information. Call EDC Customer Services for 
details. 

SIMON Vehicle Model 
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HVE Version 4 Suggested 
Computer Requirements 

Desktop Computers 

During our extensive development and testing of 
HVE Version 4, we identified several desktop 
computer configurations that provided various 
levels of HVE performance.  To help you decide if 
your existing computer is capable of providing you 
with the graphics quality and performance you 
require when using HVE, please follow these 
guidelines: 

Good: 
 

• Intel Pentium II Processor (or similar) 

• 128 MB RAM 

• 4MB OpenGL compatible Graphics Card 

• 15" monitor 

Example:  COMPAQ Presario 350Mhz PII with 
on-board 4MB ATI graphics 

Better: 
 

• Intel Pentium III Processor (or similar) 

• 128 MB RAM 

• 8MB or 16 MB Open GL compatible Graphics 
Card 

• 17" monitor 

Example: COMPAQ Deskpro 600Mhz PIII with 
8MB ATI 3D Rage Pro graphics card 

Best: 
 

• Intel Pentium III or IV processor (or similar) 

• 256+ MB RAM 

• 16MB or 32MB Open GL compatible Graphics 
Card 

• 20" monitor 

Example: Dell 420 Workstation with Windows 
2000 and DiamondFire GL2 graphics card  

*If you have any questions regarding a specific 
make or model of computer or graphics card, 
please refer to the HVEv4 FAQ page on our 
website or contact EDC directly. EDC Customer 
Service may be able to provide you with some 
additional information. 

Laptop Computer Recommendations: 

Our testing has revealed that not all laptop 
computer graphics cards provide excellent 
rendering performance when using HVE.  You will 
get excellent visual quality and speed performance 
from NeoMagic chips commonly used in Sony 
laptops.  However, we have experienced poor 
performance on laptops that use "mobility" 
versions of chips used in desktop 3D accelerators, 
specifically ATI Rage Mobility and Savage M chips 
used in some Dell, IBM and Toshiba laptops.  
However, this situation is subject to change as new 
releases of drivers become available.  If you have 
one of these laptops, it is best to check with the 
laptop manufacturer to ensure you are using the 
latest driver for your computer's graphics system. 

Operating System Recommendations: 

We also learned a lot about the Windows 95, 98, 
Me, NT and 2000 Operating Systems during our 
testing.  We have made every effort possible to 
ensure that HVE can be used with each operating 
system.  However, we strongly encourage HVE 
users to consider using the best operating system 
available for their computer hardware.  This will 
provide the user with both fast and efficient HVE 
operation, as well as stable operation for all of 
their other applications.   

For some users, Windows 98 or Me is the best 
choice.  For others, Windows 2000 is the best 
choice.  According to Microsoft's website, 
Windows 2000 far exceeds the reliability of 
Windows NT as an operating system for 
professional applications.  For more information 
about Windows 2000, please visit Microsoft's 
website at www.microsoft.com /windows2000 for 
the latest information. 

Important Note: 

We recommend that you consult with a computer 
professional regarding your total computing 
requirements before purchasing or upgrading your 
computer to run HVE.  We have learned from 
experience that it can be more efficient to 
purchase a new computer with the performance 
features you need, rather than trying to upgrade an 
existing computer. 
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Technical Session 
Rollover Simulation 
HVE allows the study of complete vehicle rollover 
using kinetic simulation (that is, the vehicle motion 
is determined by forces acting against the vehicle 
body while in contact with the ground). The 
computational method was described in SAE 
Paper No. 2000-01-0852, “Applications and 
Limitations of 3-Dimensional Vehicle Rollover 
Simulation.” An additional article appeared in the 
June 2000, Technical Newsletter. 

With the introduction of HVE Version 4, we expect 
(and hope for) a significant increase in the number 
of rollover events being simulated. Simulation 
provides an increased understanding of the events 
leading up to the crash, as well as a better 
understanding of the various mechanisms 
involved in rollover. 

A word of caution is in order. Just because it can 
now be done does not imply it can be done easily! 
This point was made in both the SAE paper and 
the Technical Session. There are two reasons for 
making this point. First is a technical problem: The 
tire models in all 3-D simulations begin by 
calculating the tire’s radial deflection due to 
contact with the ground. When, as the vehicle 
rolls, if the  tire plane becomes nearly parallel with 
the ground plane, the radial deflection can 
increase suddenly to an abnormally large value. In 
the extreme case, the tire plane and ground plane 
become parallel and any tire penetration into the 
ground results in an infinite tire deflection. This is 
a technical problem for which there are often 
workarounds (refer to the SAE paper). Modeling 
changes are also possible (in fact, likely) that will 
eliminate this issue. But, this is the easy part. 

A vehicle rollover is nearly chaotic. Witness the 
fact that it is not possible to duplicate the same 
results during repeated rollover testing under well-
controlled test conditions. While the rollover model 
is very robust and sophisticated, it is just a model. 
It is interesting to make small changes to the 
inputs and observe the changes in the results. 
Sometimes the differences are minute, while other 
times, they are significant. Duplication of a real-
world event takes time, skill and (perhaps most of 
all) luck. 

So why do a rollover simulation? Many reasons. 
One reason is to estimate the speed at the start of 
a loss-of-control maneuver. A second important 

reason is to gain an understanding of the driver 
inputs required to initiate the rollover. You will find 
that, regardless of the exact details of the rollover 
process, the total distance traveled and the 
number of complete rolls are quite speed-
dependent. Thus, rollover simulation is quite 
useful to help pin down a possible range of initial 
speeds and driver inputs. 

Rollover simulation is also useful for studying how 
various vehicle factors, such as CG height, track 
width, suspension design and tire selection, affect 
the propensity for rollover. 

Another important reason is to study the effects of 
various environment tripping mechanisms, such as 
curb tripping and soil furrowing. Although neither 
of these mechanisms is handled perfectly by our 
current point contact tire models, significant insight 
is still gained through approximate models of 
these environments. Curbs can be modeled using 
steeply sloped surfaces and a significantly reduced 
integration timestep. Furrowing can be 
approximated using terrain friction multipliers. 

With sufficient time and the proper level of 
expectation, rollover simulation can be a valuable 
new tool in your arsenal. We encourage you to 
discover how rollover simulation can assist you in 
your reconstructions.  

EDC’s Website 

For the latest product news and training course 
announcements, be sure to visit the EDC website 
at www.edccorp.com.  The website provides 
helpful information for both new and long-time 
users, such as answers to FAQ's (Frequently 
Asked Questions) about HVE and HVE-2D, an 
important listing of Technical Publications, (many 
of which can be downloaded directly from the 
webpage), and course announcement and 
registration forms for EDC training programs.  

An extremely important section on the EDC 
website is the HVE Partners page.  EDC is often 
asked if we can provide the contact details for an 
experienced HVE user who may be able to work 
on a specific type of case.  We always refer these 
callers to visit the HVE Partners page on our 
website and click on an HVE Partner's link to their 
website or email address. We plan to continue 
expanding the range of information provided via 
our website, so be sure to bookmark 
www.edccorp.com and visit often! 
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User Hints and Tips 
• Your experience while using HVE Version 4.00 

will be greatly enhanced by using a 3-button 
mouse.  You may choose one with or without a 
center scroll feature.  The key is to configure 
the mouse so that the middle button, whether 
traditional button or scroll disk, is the “middle 
mouse button”.  (An optical mouse is really 
nice because you do not need a mouse pad or 
even a flat surface to use it; e.g. a pants leg 
works great.) 

• Version 4.00 includes a new way to toggle 
between Pick and Manipulate modes: press 
the right mouse button and select Viewing.  
Alternatively, you can either press the 
<Escape> key or click the hand and pointer 
icons on the right-side tool bar. 

• HVE Version 4.00 makes use of a wide array 
of viewer functions with buttons on the right-
side toolbar (see below for descriptions).  In 
addition to the Pick and Manipulate buttons 
with which you are already familiar, the Go to 
Home view, Assign Home view, and Zoom on 
selected object functions are particularly 
useful.  Experiment! 

 

 

 

 

 

 

 

 

 
• The environment and vehicle geometry files 

that you built to use on the SGI can be used 
immediately in Version 4.00.  Simply copy 
your environment and vehicle geometry files 
directly from your SGI to your PC. They are 
ready to go in .iv format.  Similarly, copy your 
.rgb format textures files. 

• You can change the font size used in alpha-
numeric output reports by editing the 
Preferences under the Options menu.  You 
may need to decrease the font size from the 
default (10 pt) to 8 pt in order for some reports 
to fit on a printed page.  Any changes that you 
make will be saved in your configuration file, 

as are other user preferences such as units 
and background color. 

• Exporting time-based vehicle simulation data 
from HVE to a spreadsheet or graphing 
software package, such as Microsoft Excel, 
allows you to make great looking graphs and 
to graph one variable against another (i.e., 
without time as the independent variable).  It is 
simple to do this in Version 4.00.  With the 
Variable Output window selected in the 
Playback Editor (the title bar will be 
highlighted), select Print from the File menu.  
Choose a Generic/Text printer.  Click in the 
Print to File check box and press the Print 
button. Assign a file name with the .txt 
extension, and change the file type to All Files 
(*,*). Press OK.  Now, open Excel and select 
Open from the File menu.  Select the text file 
that you just created.  Use the formatting 
options to make sure that your data stays in 
the correct columns.  That’s all there is to it. 

• It is also very simple to take graphic screen 
shots of your human, vehicle, environment, or 
event.  Press either <Print Scrn> to make a 
screen shot of everything appearing on your 
monitor or simultaneously press <Alt> and 
<Print Scrn> to make a screen shot of only the 
active window.  Next, open Paint by going to 
your Start menu and selecting Programs, 
Accessories, Paint.  With Paint open, Paste 
the screen shot into the window.  Paint can be 
used to crop, add text, add shapes, and 
perform other useful functions.  When you are 
happy with your image, Save it.  This image 
can be imported into word processing, 
presentation, or publication software 
packages. 

• Use the arrow keys on the keyboard to move 
within the Driver Controls tables. 

• Use the <Tab> key to move between fields in 
the Contact Surfaces dialog. 

• HVE Version 4.00 has features that make it 
easier for you to contact us for technical 
support.  Click on Help on the main menu bar 
and choose Tech Support.  We have listed 
telephone, fax, and email contact information 
for EDC Technical Support.  Also, we have 
listed your name, company name, and user 
identification number.  Click on Help on the 
main menu bar and choose About.  Your HVE 
version number is listed.  Have this 
information available when you contact EDC, 
and you will be put through to a technical 
support engineer even faster. 

Change to Pick mode 

Change to Manipulate mode 

Access viewer Help system 

Go to Home view 

Assign Home view 

View all 

Zoom on selected object 

Toggle to orthographic view 
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HVE Version 4.00 FAQ 
 
This section contains answers to questions 
submitted to Technical Support by HVE users. 

Q: When will HVE Version 4.00 be available? 

A: RIGHT NOW!!  Enjoy. 

Q: Can I install HVE Version 4.00 on more than 
one computer? 

A: Yes. You must have the EDKEY security 
dongle attached to the printer port in order to 
run the program.  This arrangement allows you 
to use HVE Version 4.00 both on your desktop 
at work and on you laptop at home or on the 
road.  Or, share the EDKEY with a colleague in 
your office so that you both have access to 
HVE at your own desks. 

Q: Can I use my environments (and textures 
and vehicle geometries) that were made on 
the SGI? 

A: Yes, your environments can be used right away 
in HVE Version 4.00.  Just copy them onto your 
PC and into your /hve/supportFiles/ 
images/environments/ folder.  Similarly, copy 
over texture and vehicle geometry files into the 
appropriate folders and they are ready for use. 

Q: Which texture formats are accepted by 
HVE? 

A: The best file formats for textures are .tif, .gif, 
.rgb, .bmp, and .jpg.  These formats basically 
cover the spectrum of standard  formats. 

Q: Can I use my cases from the SGI? 

A: A case translator is not yet available for 
converting files between SGI and PC formats, 
but we are working on it. 

Q: Is there a SceneViewer-type utility program 
that I can use to change the transparency of 
windows, etc.? 

A: Yes, it is called SceneViewer.  SceneViewer is 
shipped as an HVE utility and has all of the 
functionality that you have used on the SGI. 

Q: What if I have only a 2-button mouse? 

A: Use a combination of your 2-button mouse and 
the keyboard to produce the same rotate, pan, 
and dolly functions. 

Function Mouse 
Button 

Keyboard 
Key 

Rotate Left  
Pan Left Shift 
Dolly Left Ctrl-Shift 

However, your experience with HVE will be 
more enjoyable if you do use a 3-button 
mouse. 

Q: What formats are recommended for new 
vehicle and environment geometry files? 

A: Both .iv (Inventor) and .wrl (VRML) format 
geometry files can be imported by HVE v.4.00.  
For 3-D environments, version 1.0 .wrl is the 
preferred format.  If you are using 3-D Studio 
for building vehicle or environment geometry 
files, simply save the file as version 1.0 .wrl. 

Q: Can I print with a non-Postscript printer? 

A: Yes, just like any other Windows-based 
program, HVE will print to any Windows 
compatible printer.  As a general tip, printer 
drivers are updated often, so check the website 
of your printer manufacturer to ensure that you 
have the latest version for your printer. 

Q: How do I make a video? 

A: First, please read the HVE User’s Manual.  
There are changes from HVE Version 3.01.  
HVE has the built in capability of creating an 
AVI file.  This can be played back within HVE 
or using an external application such as Movie 
Player.  It can also be put into various 
presentation software packages, such as 
Microsoft PowerPoint.  The process of routing it 
to videotape will depend on your video card or 
peripheral.  Refer to the owner’s manual for 
your specific video hardware. 

Q: Are there ways to store/record a movie file 
other than on videotape? 

A: Many computers now come with read/write CD 
ROM drives.  If you have this type of drive, it is 
easy to copy your AVI movie file on to a CD for 
transportation or distribution.  Among other 
benefits, the quality of this file will remain 
higher than achieved when routing the movie 
file to videotape. 
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Technical Support 
 

HVE Version 4 includes some very nice features to 
help our technical support technicians assist you. 
The Help option includes your User ID, phone 
number and the email address for the support 
desk at EDC. Every technical support call goes 
through our support desk and all calls are 
documented. You are also given a Case ID 
number for future reference (in case there is a 
need for a call-back). These steps have been 
implemented to assist us in tracking repeated 
problems. For this reason, it is important that you 
always request EDC Technical Support, rather 
than ask for a support person directly. You may 
request to work with a particular support person. 
However, that person may not be available (out of 
town, on vacation, etc.). For that reason you 
should not leave email or voice mail pertaining to 
a new case.  

EDC support technicians also meet each week to 
discuss every call logged during the previous 
week. Documenting each call allows our 
technicians to seek advice from each other as well 
as to share their solutions. 

Our technicians sometimes may ask you to email 
a case file to us for evaluation. This is quite easy 
to do. Simply send an email to the technician and 
include the case file as an attachment. In your 
email, describe the problem in as much detail as 
possible. Then click on your email program’s 
Attach option and select the case file. By default, 
the file is found in the \Hve\supportFiles\case 
subdirectory, although the user can change this. If 
the case file is particularly large (while many case 
files a about 1 MB, it is possible for a case file that 
includes numerous lengthy events to exceed 50 
MB), you can greatly reduce the file size by 
resetting each of the events prior to saving the 
case. 

All requests for technical support are responded to 
within 24 hours. Our goal is to respond within 2 
hours (our statistics show that 78 percent of all 
calls are responded to at the time of the call). 
Occasionally, information from a specific engineer 
may take somewhat longer. The time required to 
come to a solution varies greatly. Most requests 
for technical support are closed at the conclusion 
of the first call. However, some issues result in an 
ongoing dialogue. In addition, research may 
sometimes be required for complete closure of a 
technical support issue. 

One more thing that’s worth mentioning: All calls 
are strictly confidential, and you will never see us 
opposing you in court. We serve only our 
customers – not lawyers! 

Technical Support can be reached by telephone 
between 8:00 AM and 5:00 PM PST at 
503.644.4500 and by email at 
support@edccorp.com. Please be ready to provide 
your User ID#, your name, your company name 
and contact phone number when you call or 
include it directly in your email. 

EDC Vehicle Dynamics 
Course Recap 

The new EDC Theoretical and Applied Vehicle 
Dynamics course (held January 29 – 31), was well 
received by a group of enthusiastic attendees in 
Phoenix, AZ.  The course achieved the goal of 
providing a greater understanding of vehicle 
dynamics and control systems to engineers  
through a combination of classroom-based theory 
sessions and hands-on computer simulation 
workshops.  During the 3 full days of the course, 
instructor Dr. Dan Metz presented students with 
detailed lectures complete with real-world 
examples and anecdotes from his experiences. In 
the afternoon, attendees were able to "put 
themselves in the virtual drivers seat" and use a 
beta edition of HVE Version 4.00 to conduct 
simulation studies reinforcing the concepts 
discussed in the morning lectures. 

Many of the attendees were experienced HVE 
users, but even those attendees brand new to HVE 
were able to quickly adapt to the user interface 
and easily set-up their own simulation studies.  
Divided into small workgroups of three each, 
attendees were assigned specific problems 
requiring simulations to answer questions related 
to a specific area of study.  Once the simulations 
were completed, a brief presentation of their 
findings was provided by each group, and then a 
final discussion to review the whole day’s course 
material was held. 

This course will be held at a variety of locations 
around the US.  Interested in hosting the EDC 
Theoretical and Applied Vehicle Dynamics at a 
location near your office?  Contact EDC Customer 
Service to find out more information. 
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HVE Regional Demos 
EDC is offering personal demonstrations of HVE 
for those who would like a private, 1½-hour look at 
this powerful tool.  Currently planned regional 
demos are: 

Detroit, MI..........................................March 5-8, 2001 
 

Please call us in advance to make arrangements 
for your personal, hands-on demonstration.  

Training Courses 

Vehicle Dynamics 

Theoretical and Applied Vehicle Dynamics 
extends the theory of the SAE course and 
includes direct applications using the HVE 
three-dimensional simulation environment as 
well as a solid theoretical background for 
such simulations. The course is focused 
toward those with an advanced interest in 
vehicle dynamics, accident reconstruction 
and simulation.  

EDC Reconstruction & EDC Simulation 

EDC provides excellent 1-week training courses 
on the use of EDC Reconstruction or Simulation 
software.  Even long-time users agree that the 
courses are extremely beneficial and challenging. 

The courses are designed to investigate fully the 
program’s inner workings.  Lectures are full of 
helpful hints gained from years of experience.  

 

HVE Forum 

The HVE Forum is an excellent opportunity for 
HVE, HVE-2D and EDVAP users to jump to a new 
level of ability.  By participating in workshops and 
special lectures, attendees can brush up on their 
present skills, learn new techniques of applying 
simulation modeling, and learn how to use the 
latest advancements in the software.  The HVE 
Forum also presents a great opportunity to meet 
other users and expand your network of resources 
and information. 

Course Registration 

Our courses are often full, so be sure to register 
early to avoid missing out!  You may register for a 
course simply by contacting EDC Customer 
Service at 503.644.4500, or by sending an email 
to training@edccorp.com.  We look forward to 
seeing you at our next course! 

NUCPS Training 
NUCPS (previously NUTI) offers four different 
courses using EDVAP and/or HVE-2D. For more 
information about the courses and registration, 
please contact NUCPS at 800.323.4011. 

 Northwestern University Center for Public 
Safety Training Courses 

MATAR (EDCRASH) 

Evanston, IL .................................March 19-23, 2001 

COMPTAR I (EDCRASH) 

Evanston, IL .................................March 12-16, 2001 

COMPTAR III (EDSMAC) 

Evanston, IL .................................March 26-30, 2001 

COMPTAR IV (EDCRASH & EDSMAC Extended) 

Evanston, IL ......................................... Call for dates 

Engineering Dynamics Corporation 
8625 SW Cascade Boulevard, Suite 200 

Beaverton, Oregon 97008-7100 USA 
Phone 503.644.4500 / FAX 503.526.0905 

Website:  www.edccorp.com 

Windows is a trademark of Microsoft Corporation. 

GATB is a trademark of Collision Engineering Associates, Inc. 

EDVAP, EDCRASH, EDSMAC, EDCAD, EDSVS, EDVTS EDHIS, EDVSM, EDVDS, 
EDGEN, EDVDB, GetSurfaceInfo(), HVE-2D, HVE and HVE Brake Designer 
are trademarks of Engineering Dynamics Corporation.  All Rights Reserved. 

SIMON and DyMESH (Patent No. 6,195,625) are registered trademarks of 
Engineering Dynamics Corporation.  All Rights Reserved.   

Engineering Dynamics Corporation 
Training Courses 

 
EDC Simulations 

Los Angeles, CA.................................................TBD 

Coral Gables, FL…………….. November 13-17, 2001 

EDC Reconstruction 
Los Angeles, CA................................. January, 2002 

Theoretical and Applied Vehicle Dynamics 
Future dates and locations to be announced. 

2001 HVE Forum 
Santa Fe, NM ...................................May 7-11, 2001 


